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Running the PC Software

Before running the TMS-Pro control software, your PC should be connected to the 
test stand that has a load cell connected to it (refer to the hardware manual). 
Texture Lab Pro will not proceed to function until checking whether:

1. The PC is connected to a test stand 

2. The test stand is turned on
3. A load cell is connected to the test stand 
4. The load cell is calibrated

5. No significant residual load is being registered by the load cell
7 The test stand is not reporting an unresolved fault condition

A negative result on point (1), (2) or (3) will display a warning message, but clicking 
on the OK button will allow the software to load in limited functionality mode. In this 

mode, existing test data can be inspected and processed, but new test data cannot
be accumulated. When in limited functionality, any attempt to re-connect will re-

display the appropriate warning message. A negative result on point (5) will offer 
options of either entering the Calibration & Service screen or closing TMS-Pro. A 
negative result on point (6) will display a warning message and offer the option of 

backing-off the residual load and displaying a load of zero; clicking on OK will allow 
the software to continue loading. A negative result on point (7) will display a 

message advising the operator to contact his Food Technology agent.

When starting, TMS -Pro will also advise the operator in the event of:

1. A load cell that has never been connected to the system being detected. TMS-
Pro will then update the database of available load cells. 

2. The current “maximum load” setting exceeding the capacity of the load cell. 
TMS-Pro will automatically adjust this setting to the capacity of the load cell.

When the Texture Lab Pro software is first started, the program will prompt for 
Operator or Master and then ask if the operator wants to calibrate the absolute 

position. This is an optional routine but can be very helpful for repeat test set ups. If 
you click no, the software starts right up. If you click yes, the software will prompt 
you to check to make sure there is nothing preventing the cross head from moving 
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all the way up. If all is clear click “OK” to proceed. The test stand will move to the 
absolute top position and back down a few millimeters. 

This will now be the “Zero” position for displacement measurements. The zero 

position is held in the test stand memory until the test stand is powered off or it is 
changed by the operator or program. This allows programs to be written that 
require the test stand’s cross head to be positioned at the exact same place from 

day to day. Such a condition is necessary for tests employing the CS-1 Kramer 
Shear cell. The top portion of the test cell needs to be at the correct height in 

relation to the bottom assembly in order for the blades to mesh properly in the top 
grid.

Using Windows Software

Figure 1: A typical dialog box

This section applies to all Windows software, not just to TMS-Pro. When 

the operator selects an option from a menu or a toolbar, a “dialog box” 

will appear. The “typical dialog box” shows the different facilities 

available within Windows for operators to set-up software to behave 

according to their preferences.
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A dialog box needs to control a number of features that are related. 

However, attempting to control all the available features within one 

screen can very easily become “messy”, but completely separating related 

features can make software less intuitive. The solution is to separate 

groups of features with “tabs.” The dialog box above has two tabs (1); it 

shows the right hand tab selected. Clicking on the left -hand tab will 

display another group of features from which the operator can choose.

It will often be necessary for an operator to make one choice from a list of 

options. When the list is relatively short (typically two, three or four 

items), this is done with a group of “option buttons” (also known as “radio 

buttons”.) There are four option buttons in the screen shot above (2). 

Clicking into one of the three “empty” buttons will move the black dot 

there, and the new choice will have been made.

When it is necessary to choose one option from a longer list, a dropdown 

list box (or “combo box”) is used (3). Clicking on the down arrow to the 

right of the box (as illustrated by the cursor) displays a list; clicking on the 

appropriate item in that list will update the box, and the new choice will 

have been made.

Windows has a facility for the operator to type in something for the 

software to work with. Two boxes are indicated by (4). The operator can 

type whatever he likes into either box. The upper box is a “text box” and 

it will accept most characters that are typed into it. The lower box appears 

just the same, however it is a “value box”, so the software is expecting a 

number to be typed into it. The software will at some stage reject non-

numeric input, and insist that an appropriate number be typed in.

Sometimes the operator will be able to choose more than one option from 

a list. This is usually arranged with a group of “checkboxes” (5). Three 

such boxes are illustrated above, and just the left -hand option has been 

chosen. It is possible however to choose any one, two, or all of the three 

options by clicking in a checkbox and turning the tick on or off.

There are usually two buttons that enable the operator to return to the 

main program. The OK button carries out all the changes made within the 

dialog box, whereas the Cancel button ignores all such changes.

Dialog boxes usually also contain a number of buttons. The label on each 

buttons describes the effect of clicking on that button. Note that the label 

on one of the buttons (6) is grey rather than black.

An important general feature of Windows software is illustrated in (6) 

above. If, for example, current settings make an option or operation

inappropriate or unnecessary, or, possibly, the absence of data makes the 

completion of a task impossible, Windows will use grey text to indicate 

that, for the moment, a feature has been disabled.

The operator can, by choosing Toolbars option from the Display menu, 

decide whether to display the Standard toolbar and the Load / 

Displacement toolbar.
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Note: The Load/Displacement toolbar will be disabled, if no LOAD 

CELL or RTC was detected on boot-up.

The Start button will be disabled until a test program  is loaded or written.

Setting Zeroes
The Load/Displacement toolbar enables load or displacement values to be 

set or re-set. Rather than set the load or displacement to zero manually, it 

might be better to use the ZERO command in the first line of a program

Click on the Zero Load button and the value appearing in the “Load” 

display box will change to zero, i.e. the operator will have been able to 

tare out the weight of the test cell, or any residual load in the sample. 

Clicking on the Restore Load button will restore the “true” reading.

Note: clicking twice on the Zero Load button will mean that the “true” 

load reading is irretrievably lost - as far as the “Load” display box is 

concerned.

Click on the Zero Displacement button and the value appearing in the 

“Displacement” display box will change to zero. TMS-Pro will 

“remember” the position of this zero, and clicking on the Park button, will 

return the crosshead to this position.

Within the program, clicking on the appropriate drive button in the Test 

screen will initiate movement of the crosshead. The drive button and the 

displayed speed will flash red, when the crosshead is being manually 

driven.

A single click on the upper drive button will start the crosshead moving 

up at 5mm/min (or the minimum speed if greater), subsequent clicks will 

scroll the speed through 10, 20, 50, 100, 200, 300mm/min etc. – until the 

top speed is reached. Clicking on the lower drive button will scroll the 

speed back through the above list. The crosshead can be made to move 

down by using a similar procedure. When the crosshead is driven 

manually, readings in the “Displacement”, “Speed”, and (if appropriate) 

“Load” display boxes will be updated

Within the program, any of the following will stop the crosshead moving:

Clicking on the grey Start button

Clicking on the Stop button

Pressing the [Space Bar]

Pressing the [Esc] key

Pressing the control panel [Emergency Stop] button
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Figure 2: The TMS-Pro Main Operating Screen
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Program Development

Writing a program with TMS-Pro essentially involves three  things:

1. Telling TMS-Pro what commands to send to the test stand – choose the 
Program option from Test menu for this

2. Telling TMS-Pro you want to do with the data generated during the test – choose 

the Calculations option from Test menu for this

3. Telling other people about the samples you are testing, what you are trying to do 

to them, and possibly why – choose the Notes option from Test menu for this

TMS-Pro needs to understand the first 2 steps so these instructions will need to be 
written in a particular format. Consider the expression:
 RESULT = FUNCTION (PARAMETER)

This is mathematical shorthand for; take the PARAMETER (s) do something to it 
which is described by FUNCTION and that will give you the RESULT. A function 

can have more than one parameter, RESULT = AREA (WIDTH, LENGTH)
Once TMS -Pro has been told both the length and width, it will be able to multiply 
the two together and calculate the area.

The program facility and the calculations facility of TMS -Pro both feature an 

interface that will help you develop commands and calculations of this kind. 
Choosing either Program or Calculations option from Test menu will display a 
dialog box containing three text boxes. Clicking on the arrow to the right of the 

Command box will display a list of the entire program or calculation functions
available.

Select the required function by clicking on it. 
Now specify the parameter(s) of the function, by clicking on […] button to the right 

of the Parameter box.

A new dialog box will be displayed, but the OK button will be disabled until a value
for all the required parameters (in the units indicated) have been typed in. 
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Click on the OK button and the Parameter box will be updated.  Click on Append 
and a new line will appear, in a numbered position, in the main text box.

Repeating the procedure above will enable a series of program commands (i.e. a 

program) or a series of calculations to be developed. Clicking on the Print button 
can print out a list of calculations or program commands.

The TMS-Pro software uses two types of files; Library files, (with an extension of 
.lib) and data or “force” files (with an extension of .for). They both contain all of the 

same program, calculation and user preference data. The exception is that the data 
files (.for) contain the accumulated test data acquired during the testing session. 
Because of the  high data acquisition rate of the TMS -Pro, data or force file can be 

quite large. 

Editing Programs
Load the test program, either by choosing Open option or Load Library 

Program option from File menu. Minor changes to any program line or 

calculation can be made by choosing either Program or Calculations 

option from Test menu then selecting the line to be changed by clicking 

on it. 

Then click on […] button to display the parameters of the line selected in 

the Parameters text box. 

Click and edit within that box, make the necessary corrections. 

Finally, click on OK and then Update and the selected line within the 

main text box will be updated.

A single line may be permanently deleted by clicking on Remove. A 

single line may be moved by clicking on Cut. The Paste button becomes 

enabled, thus indicating that the line just cut has been stored. Select a line, 

click on Paste, and the cut line will be added just before the selected line. 

The Copy button behaves in a similar manner to the Cut button, but the 

selected line is not removed from its original position – thus enabling a 

line to be duplicated.

The same line can, when required, be duplicated several times by cutting 

(or copying) and then repeating the pasting procedure. Lines can be 

duplicated into adjacent positions by clicking on the line to be duplicated, 

and then clicking on the Insert button.

A block of lines can be removed by selecting the line at the end of the 

block, then repeatedly clicking on Remove.

Several load set points can, for example, be efficiently determined by 

duplicating a line, then using the Update feature to make minor changes to 

the parameter(s) of that line.
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All lines within the main text box can be removed by clicking on Clear 

All. This feature may prove to be useful, for example, when several 

completely different sets of calculations need to be saved in association 

with a “standard” set of program commands.

De-bugging Programs

Choosing either Program or Calculations option from Test menu will 

display dialog boxes with similar layouts. The Program dialog box does 

however include one extra feature – a “Debug Program” checkbox. 

Enable the box by clicking in it, click on the OK button to return to the 

main testing screen, then try to run the program by clicking on the Start 

button; the de-bug window will be displayed. Step-by-step” de-bugging is 

a useful technique for diagnosing errors that are caused by a variable 

temporarily assuming a value that the programmer might not have 

anticipat ed

The Debug window contains two text boxes, three buttons and a 

checkbox. The text box on the left displays each line of the test program ;

the box on the right displays the value of each variable and the current 

message.

Click on the Run Program button, TMS-Pro will highlight the first 

program line and try to execute that line. If the line contains an error, a 

warning message will be displayed. If the line contains no error(s) TMS-

Pro will update the value of each of the variables, the 

message text, and then move on automatically to the next line.

Some program lines, which contain no errors, might be executed so 

quickly that it would not be possible to observe the consequences before 

reaching the next line(s). Under these circumstances it may be useful to 

click in the “Single Step” checkbox, this will enable the Next Step button. 

Click on the Run Program button, and then click on the Next Step button. 

The first program line will be executed as above, but TMS-Pro will not 

execute the second line until the Next Step button has been clicked on 

again.

When de-bugging a long program it is not essential to run through the 

whole program. Simply click on Cancel to return to the main Programmed 

Testing screen.

Modifying Programs
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It will often be necessary to make small modifications to a program. 

Modifications to a library program  can be made, and the program can be 

re-saved or saved with a new name, as required. There must however be 

restrictions to modifying a test program .

There is no restriction to modifying the calculations associated with a test 

program. TMS-Pro, if necessary, can take care of recalculating results –

but arranging to re-test all samples is not possible

Imagine, for example, that a sample has been tested at 25mm/min, then 

the program, calculations and data are saved. If the program were 

modified by changing the test speed to 50mm/min, it would be 

inappropriate to allow the new test program to be saved in the same file as 

data from the old program. Therefore choosing Program option from Test 

menu will, whenever appropriate, display a message warning that it will 

only be possible to save a modified program, together with any associated 

data, if a new file name is chosen.

Note that it is possible to save data from different test procedures within 

one file - i f an ENTER command is used to vary test conditions. It would 

only be appropriate to use such a technique during program development 

to investigate the effect of systematically varying a particular parameter

within a test procedure.

Saving Library Programs
While developing a test procedure, it should regularly be re-saved by 

choosing Save Library Program option from File Menu, and clicking on 

Yes. TMS-Pro warns that a file with the same name already exists. 

Whenever significant modifications have been made to a program, it is 

good practice to save it under a new filename. If.”TEST7a”, has been 

changed significantly, it would be appropriate to save it as “TEST7b” or 

“TEST8”

Once both the test procedure and its calculations are operating in a 

satisfactory manner, it should be saved as a library program with an 

appropriate filename. It might then become appropriate to delete all the 

files saved while the final program was being developed.

Loading Library Programs
Files which have been saved into TMS-Pros library of test procedures can 

be loaded by choosing Load Library Program option from File menu,

selecting the appropriate library file by clicking on it, then clicking on 

Open button.
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TMS-Pro also has the facility to load (as a single operation) a test 

procedure, calculations, sample description, graph customizations and 

associated test data (a data .for file) by using Open option from File menu.

Programming Tips
Load cells are delicate instruments. Although the TMS-Pro has integral 

features to protect against overload, no software can react sufficiently 

rapidly to a near infinite rate of increase of load to ensure protection under 

all circumstances. If, for example, a test running down at high speed 

drives the load cell and probe into the metal plate at the base of the stand, 

it is quite likely to inflict irreparable damage upon the load cell. Some test

routines do however require that the load cell probe touches onto a solid 

fixture. When developing programs for such applications, it is strongly 

recommended that slower speeds and greater margins of overload 

protection, relative to those that will be ultimately required, are set. Then, 

when the new test program is fully debugged, the final test parameters can 

be selected.

When testing a sample for the first time the programmer may have 

absolutely no idea what the maximum and minimum values of the x-axis

and y-axis ought to be. Therefore, when developing a new program it may 

be useful to set a small range for both x and y-axes. TMS-Pros auto-

ranging facility will then automatically expand these ranges to 

accommodate the test curve. Once a program has been developed and the 

maximum and minimum values likely to be encountered have been 

established, it is recommended that, before saving the program, ranges 

should be set to values 10 or 20% greater than those likely to be 

encountered. The reason is that, after a series of test has been running for 

some time and auto-ranging does becomes necessary, TMS-Pro may need 

to re-plot some hundreds of thousands of data points. Even with a fast PC, 

this could take quite a long amount of time. The delay associated with re-

plotting data during a test becomes even more significant if the multi-

trace facility is active.

Discarding a Test
When performing a series of tests it is possible that you will not wish to 

keep data for all the samples that you have tested – perhaps one of the 

samples had some foreign material in it. If the Allow Sample Deletion 

box is checked in the Preferences settings, under the Set Up menu, data 

from any test can be discarded by clicking on the “trash can” button. The 

remaining samples will all be re-numbered, and the file will be saved 

without the data for the sample you wish to discard.

PROGRAM COMMANDS
In order for the TMS-Pro to perform a test, you must tell it what to do. 

This is accomplished by a list of commands compiled into a program. The 

TMS-Pro has 16 commands to choose from. The program can be as 

simple as 2 lines, go to a point and stop, or many lines as in a multi stroke 
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test with changeable set points. In many cases the program will only need 

to contain a few lines of instruction. If you have a special case and need 

assistance, always feel free to contact FTC for help. Programs and 

calculations can be easily created elsewhere and emailed to you.

Program commands can be described in the following general manner:

FUNCTION (PARAMETER 1, PARAMETER 2 …..)

Many parameter fields can be left blank and TMS-Pro will, where 

appropriate, execute the command on the basis of a default value. The 

section dealing with individual program commands gives details of 

default values and required parameters.

A typical example of a RUN command would be:     RUN (125, 75,  , 60, 

)

Once the user has created this command and added it to the program, 

TMS-Pro will display the corresponding command line in a sentence style 

format:

RUN @ 125mm/min until load = 75.0N, or time = 60.000sec

It is not necessary to enter numeric values into every parameter field. Any 

function which requires a numeric value in one of its parameter fields will 

also accept a variable rather than a constant value. The command line:

RUN @ 125mm/min until load = V7N, or time = V2sec

is equivalent to the RUN instruction in the above paragraph if V7 is 75 

Newton and V2 is 60 seconds. This allows any program line to be much 

more flexible.

TMS-Pro will also change the parameters of program functions whenever 

the preferred units are changed in the Preferences dialog box. TMS-Pro

will not allow dimensional conflict within variables. It will detect and 

reject an instruction to RUN to a load of 75mm, or a time of 60 Newton. 

Many parameter fields can be left blank and TMS-Pro will execute the 

command on the basis of a default value; details are given in the section 

dealing with the individual command.

RUN

Syntax: RUN (speed, load, displacement, time, break %)
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Run at given “speed” - TO a given “load”, OR a “displacement”, OR for a 

given “time” OR until a  “break criterion” is met. Note that negative 

values of speed are allowed, and thus the direction of crosshead 

movement can be controlled given that the test is a compression or tension 

based test (see Tension or Compression under the Set UP Menu 

Commands).

Example:  RUN @ 100 mm/min until load = 20.0N, or displacement = 

3.00mm, or time = 40.000sec, or break % = 5

Note: the above command makes use of every available parameter. 

Commands must provide every required parameter but they need not use 

optional parameters

Required Parameters: Speed, AND at least one of the following:

“load”, “displacement” or “time”.

Optional Parameters: break %” (this must be between 1 and 100)

Example: The program command line: “RUN @ 50mm/min until 

displacement = 140mm, or break% = 10%”

means “run at a speed of 50 mm/min until either the displacement reaches 

140mm or the load suddenly drops to below 90% of the highest value 

observed during execution of this RUN command” 

The break detect feature will be dormant until a load greater than 2% of 

the LOAD CELL capacity is observed – otherwise, at very low loads, 

false break events will be detected. TMS-Pro will not accept a command 

just to run, at a given speed, to a to a 10% break. It needs to know when to 

stop executing the RUN command if the sample does not break. This can 

be achieved by also entering a relatively large value of load, displacement 

or time. In the example given, the programmer expects break to occur at a 

displacement much lower than 140

REPEAT

Syntax: REPEAT (loop to line, times)

Description: Repeats part of program by jumping to a given “line” for a 

given number of “times”

Example: REPEAT 20 times from line 10

Required Parameters: “loop to line”
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Defaults: “times” = infi nity, (i.e. cycling continues forever)

Restrictions: “Loop to line” and “times” must be integers, positive and 

non-zero

“line”  must refer to a line which exists and cannot be a variable

Example: “REPEAT ? times from line 7”

means “jump to line 7 every time”

REPEAT primarily has been designed to transfer control to a different 

part of the program. It will often appear after an IF command. REPEAT 

needs to be used to determine number of cycles to failure, because the 

loop could include a RUN command with the break detect facility active.

MESSAGE

Syntax: MESSAGE (message text)

Displays a message on the Test screen. It is possible to move the message 

by dragging, if needed. Use this command when you want to ask the 

operator to do something or advise what is happening now. When you 

move the message box TMS-Pro will display any further messages in the 

new position.

Example: MESSAGE "Testing the sample"

Required Parameters: “message text”

Restrictions: “message text” string must not exceed 110 characters

Example: If it is necessary to prompt the operator to do something, and 

tell the system to wait until it receives an instruction to continue the test, 

this can be achieved with:

MESSAGE "Please load new sample, then click the [Resume] button" 

PAUSE for ? sec, audio disabled

The above program can be refined by using the feature of the MESSAGE 

command which enables the value of a variable to be displayed. If the 

(dimensionless) variable V3 is being used as a counter, then:

MESSAGE "Please load Sample {V3}, then click on the [Resume] 

button"

PAUSE for ? sec, audio disabled will halt the program, advise the

operator which sample should be loaded next, and wait for the instruction 

to continue.
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CLEAR MESSAGE 

Syntax: CLEAR MESSAGE 

Description: Clears message from the Test screen

Example: This might be used to remove a prompt that was telling the 

operator to do something. However once the operator has responded to it, 

leaving the prompt there would be confusing. Alternatively a new 

message, “The test is continuing”, could be written by using another 

MESSAGE command.

CYCLE

Syntax: CYCLE (speed, {x}, upper, lower, cycles)

Description: Run at specified “speed” between “upper” and “lower” 

values for specified number of “cycles”. The values must be “load”, or 

“displacement”

Example: CYCLE @ 1 in/min 50 times between –4 in and –30 in

Required Parameters: “speed”, {x}, “upper”, “cycles” 

Restrictions: {x} cannot be time,  “cycles” must be integer number 

between 1 and 1000’  value of “upper” must be greater than “lower” and 

within capability of system.

Optional Parameters: “lower”

Defaults: “lower” = {current value of x}

Restrictions: values within capability of system

Examples: After touching the top of a sample, and Zeroing the 

displacement, the command “CYCLE @ 25 mm/min 10 times between 

0.00mm and 12mm”, might typically be used simulate a chewing 

mechanic on the sample. Note that the sign of the speed will determine the 

initial direction of motion of the crosshead. In the particular case of 

determining number of cycles to break, it is necessary to use the REPEAT

command.

IF

Syntax: IF (parameter, condition, test value, true line number, false line 

number)

Description: A conditional test determining to which line the program 

goes next. 



16 • Program Development Food Technology Corporation Texture Lab Pro

A dropdown list box offers “load”, “displacement”, “time” or any 

variable, for the first parameter; clicking [Enter] will have no effect until a 

valid condition statement has been completed. 

Example: IF V1 <= 30.00 go to line 4 else goto line 50

Required Parameters: “parameter”, “condition”, “test value”, “true line 

number”

Defaults: “false line number” = next line

Restrictions: First field must be a “condition” (as illustrated)

“line number” must exist and cannot be a variable

Example: A spring is compressed to a specified length (which might, for 

example, represent the size of the assembly into which it will be 

installed).

The command IF load < 55.0N goto line 24 else goto line Next Line will, 

while the program is running allow TMS-Pro to decide whether the spring

is within specification. If the load is sufficient, a MESSAGE command in 

the next line will advise the operator that everything is OK, and the 

following lines could then release the spring and END the program. If 

however the load is not enough, the program will jump to line 24 which 

will need to be an appropriate MESSAGE command, perhaps MESSAGE 

"Reject this spring, or add a shim" 

Note: the “less than” symbol in this example could be replaced by a

“greater than” or “equals to” symbol, if required.

The END command in this example will stop the program execution 

“dropping through” and possibly arriving at line 24 even though the 

condition was not satisfied.

ZERO

Syntax: ZERO ({x1}, {x2})

Description: Zeroes the value(s) of “load” and/or “displacement”.

Note that TMS-Pro will “remember” load and displacement zero settings, 

even after execution of the program finishes. Click on the appropriate 

checkbox for the parameter(s) that needs to be set to zero.

Example: ZERO value of load and displacement

Required Parameters: {x1}

Restrictions: This command cannot be used to set “time” to zero. 

However “time” can be reset using CLEAR DATA
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Example: Cyclic tensile load needs to be applied to a length pasta. The 

RUN command should be used until a small increase in load is detected. 

At that point, having “taken up the slack”, the command “ZERO load and 

displacement” will start the “real” test with data accumulating at the 

origin of a load/displacement graph. 

Note: by zeroing the load, any residual weight of the test sample has also 

been compensated for.

A ZERO command can be “undone” with the RESTORE command. Note 

however that if the ZERO command is executed twice it cannot be 

undone.

A ZERO command will usually be used in conjunction with a CLEAR 

DATA command. 

If the CLEAR DATA command is omitted, then the occurrence feature 

which appears in many of the calculation commands (i.e. the VALUE

command) may produce unexpected results. In the example above, if the 

load at a particular displacement is required, then after “taking up the 

slack”, use a CLEAR DATA command, and ask for the load at the first 

occurrence of that displacement. 

Note that the ZERO command has the opposite effect to that of the 

RESTORE command.

RESTORE

Syntax: RESTORE ({x1}, {x2})

Description: Restores the value(s) of “load” and/or “displacement”. This 

command is the reverse of the ZERO command.

Example: RESTORE value of load

Required Parameters: {x1}.

Restrictions: This command cannot be used to re-set “time”.

Example: Touch on

CLEAR DATA 

Syntax: CLEAR DATA 

Description: Clears all data which have been accumulated up to this point
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Example: TMS-Pro test data files can become very large. Therefore 

avoiding storing unnecessary data is good programming practice. There 

are many types of test that initially accumulate data that do not really need 

to be retained. Using a CLEAR DATA command immediately after the 

CYCLE command means that only the “proper” part of the test will be 

recorded once a test has been completed, the crop feature can be used for 

stripping out redundant data. There is no facility to “undo” this command 

in the manner that the RESTORE command will undo the most recent 

ZERO command.

CLEAR GRAPH 

Syntax: CLEAR GRAPH 

Description: Clears trace from graph, and re-draws axes

Example: Many tests will accumulate data at the start which do not really 

need to be retained. Using a CLEAR GRAPH command means that the 

meaningful part of the test data can be accumulating only. There is no 

facility to “undo” this command in the manner that the RESTORE

command will undo the most recent ZERO command.

PAUSE

Syntax: PAUSE (time)

Description: Delays the execution of the next program command, while 

logging and display of data still continue. 

Example: PAUSE for 100 sec, audio enabled

Required Parameters: “time”

Defaults: “time” = infinity

Example: A MESSAGE command instructs the operator to remove the 

old sample and fit a new one. Overestimating how long this will take and 

programming in this time is bad programming practice – because it would 

be inefficient. Underestimating how long this will take is infinitely worse 

programming practice – because it would be dangerous. To address this 

particular dilemma, the “Pause time:” box may be left blank. When TMS-

Pro encounters this command, the Stop button will be changed to Resume 

and program execution will be halted until the operator clicks on that 

Resume button. When no pause time is entered, the command will re-

display in pseudo-sentence format as “PAUSE for ? sec, audio disabled”

Safety Note: Any motorized test stand has the potential to inflict serious 

injury upon an operator or passer-by, to minimize this risk a number of 

precautions should always be observed. Never leaving an operating test 

frame unattended is one such precaution. The PAUSE command (because 

it enables an apparently inert test frame to suddenly start operating again) 

does represent a hazard in this particular context. Consequently TMS-Pro
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has an audio warning facility incorporated into the PAUSE command; this 

will sound an alarm five seconds before the crosshead starts to move. 

When a pause duration of ten seconds or more is typed in, a checkbox to 

activate the audio alarm will become enabled – it is strongly 

recommended that this feature be always used. The audio warning facility 

requires that your PC be fitted with an appropriate sound card and 

speakers. Your IT department will be able to arrange this.

END

Syntax: END

Description: Prevents any subsequent program lines being executed

Example: Putting this at the end of any program would be tidy, but putting 

it in the middle of a branched program could be vital. See the example 

given with the IF command.

ENTER

Syntax: ENTER (units, name, variable)

Description: Accepts and allocates input from keyboard.

Example: Enter @ “Duration of relaxation?”, time value (sec) for V4

Required Parameters: “units”, “name”, “variable”

Restrictions: “variable” must be V0, V1, V2……V48, V49 “name” must 

be no more than 50 characters

Example: When TMS-Pro encounters the program line 

ENTER @ “Enter a load to which the component should be compressed 

now.”, load value (N) for V3, 

Will pause the program and display the message “Enter the load to which 

the component should be compressed now.” Clicking on the OK button 

will allocate the entered value to the variable V3, and resume program 

execution. Obviously the next program line is likely to involve a RUN

instruction, perhaps

RUN @ 125 mm/min until load = V3N, or time = 40.000sec

When the test is repeated TMS-Pro will “remember” the most recent 

value of a variable, until either a CLEAR VARIABLES command, a 

FORMULA command or another ENTER command is encountered.

It is important whenever possible to ensure that all ENTER commands are 

executed before any load is applied to the sample. Imagine the result if a 

non-elastic sample is loaded up to a certain point, then an ENTER 

command is executed and the corresponding prompt is displayed but there
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is a five minute delay before the OK button is clicked, some results could 

now be completely useless - because the sample may well have relaxed by 

a significant amount.

The execution of an ASSIGN command which is, in effect, an “automatic 

ENTER command” will still involve a minuscule delay; this is true of any 

command.

ASSIGN

Syntax: ASSIGN ({y}, variable)

Description: Allocates a current value to a variable

This is an automatic version of the ENTER command

Example: ASSIGN displacement to V2

Required Parameters: {y}, “variable”

Restrictions: “variable” must be V0, V1, V2……V48, V49

Example:    ASSIGN load to V1 or ASSIGN displacement to V3

CLEAR VARIABLES 

Syntax: CLEAR VARIABLES 

Description: Re-sets the value of all variables to zero; also re-sets the 

dimension.

Examples: This command enables the programmer to make it clear that a 

particular phase of a test has been completed. Consequently, the program 

becomes easier for another person to understand. It is often useful to run 

an “initialization” program, which might, measure (and “remember”) the 

length of a typical sample, then run a “main” program which actually tests 

a number of samples. A powerful feature of TMS-Pro is that all variables 

stored will be retained until TMS-Pro is re-booted. Unfortunately, what 

might be a powerful feature for one group of operators could be an 

annoying feature for another. The CLEAR VARIABLES command is for 

the benefit of this second group.

FORMULA

Syntax: FORMULA (equation)

Description: Allows variables to be operated upon mathematically during 

a test, using the four standard arithmetical operations.

Example: V1 = V2 + 1 

V2 must be a dimensionless number, or a dimensional conflict error will 

occur
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Required Parameters: “equation” 

Restrictions: “equation” must be an equation, without dimensional 

conflict and cannot exceed 110 characters

Example: A particular sample resists motion within an acceptable range of

forces – until a critical speed is exceeded. A program to test it at a speed 

of V7 then keep doubling speed and repeating the test until a certain force 

is exceeded would involve the program line,  V7 = V7*2.

Note: it is important not to confuse the FORMULA command with the 

DO-SUM command. The FORMULA command is to create/modify a 

variable (i.e. load, displacement, time, number or speed) which TMS-Pro

may need to use during a test. It is not for complex calculations that can 

be carried out after a test. If this command is used to create a variable 

which cannot be used during a test (a volume, area or slope perhaps) any 

attempt to use it will not be accepted.
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CALCULATION COMMANDS
After testing a sample and collecting the data, it is always necessary to 

perform calculations on the data to transform test data into meaningful 

information. This is done with the calculations functions.

Calculation commands can be described in the following general manner:

RESULT = FUNCTION (PARAMETER 1, PARAMETER 2…)

Many parameter fields can be left blank and TMS-Pro will, where 

appropriate, execute the command on the basis of a default value. The 

section dealing with each individual calculation command gives details of 

default values and required parameters.

Example: VALUE (displacement, load, 163, 5,, 2, “Point X”, show result 

)

Once the user, by choosing appropriate parameters, has created this 

command and added it to the list of calculations, TMS-Pro will display

the corresponding calculation in pseudo-sentence format:

VALUE of displacement (“Point X”) @ 163N (for occurrence 2, between 

load at 5.00 sec and End of test sec), Assign to V7, Show result

This command would mean:

“Find the displacement (position) at which the load (force) value 

passed for the second time, through 163 Newton, but do not start 

counting until 5 seconds after the start of the test, then keep going 

until the test has finished. Assign the result to the variable ‘V7” and 

show the result as “Point X” in the test results section after the test”.

It is not necessary when writing a program to enter particular values into 

every parameter field. Variables can also be used in the calculations and 

program commands. They are designated as V0, V1, V2, V3, etc. There 

can be up to 50 variables used in a test, (command / calculation) set up. 

Any function, which requires a numeric value in one of its parameter 

fields, should also accept a variable rather than a particular value. 

Calculation results can be displayed or hidden as required. If the 

calculation is just an interim value for determining another more 

meaningful result, then check the “Hide Result” box in the command’s 

window.
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It is important to note that a variable used in a program command can be 

also applied as assigned, in the calculations commands. Therefore if one 

does not intend to share the same value for a variable in both the program 

commands and the calculations after, then different variables would need 

to be assigned.

The calculation line:  VALUE of displacement (“Point X”) @ V2N (for 

occurrence V0, between load at V9 sec and End of test sec), Assign to V7, 

Show result is equivalent to the VALUE instruction in the above 

paragraph if V2 is 163 Newton, V9 is 5 seconds, and V0 is dimensionless

with a value of 2. 

This allows any calculation to be much more flexible. TMS-Pro will not 

allow dimensional conflict with variables; it will detect and reject a 

VALUE instruction involving a load of 163 mm, or an occurrence count 

of 3 Newton. TMS-Pro will also, automatically change the parameters of 

all program and calculation functions whenever the preferred units are 

changed in the Preferences dialog box.

It can be frustrating to write a program asking TMS-Pro to return the peak 

load between 17 and 32mm, and then, when you are actually able to look 

at a graph of your data, see that the peak you were really interested in 

actually occurred at 33 mm. TMS-Pro will let you return to the Test

Program facility and change 'PEAK in load = f(displacement), between 

17.00mm and 32.00mm, with order of 1, condition = 10%' to 'PEAK in 

load = f(displacement), between 17.00mm and 35.00mm, with order of 1, 

condition = 10%'. The program will then recalculate the results.

Most all of the calculations results can be linked to a variable, given a 

name, (such as “Chewiness”) or can be hidden from the test result at the 

end. Sometimes a calculation will be made for reference purposes only 

within the test and the result need not be displayed.

Multi-valued Functions

Consider the equation:  Y = 5 X. When TMS-Pro is given the value of ‘x’ 

and asked to calculate ‘y’ it is easy because for any value of ‘x’ there is 

only one possible value of ‘y’.  Unfortunately many functions are either 

inherently multi-valued, or else noise on a signal can make an inherently 

single-valued dataset multi-valued. Consider the following curve:
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Force is on the 'y' axis and position is on the 'x' axis. If you ask the 

software to tell you the load when the position is 3 that is easy, because 

there is only one answer. However if you ask for the value of position 

when the load is 7, that is a difficult because there are lots of correct 

answers.

When testing your product and asking the software to return a value of ‘x’ 

for a particular value of ‘y’, you are likely to find that there are many 

different answers. You will probably regard one answer as ‘right’ and all 

the others as ‘wrong’. Many of TMS-Pro’s calculation commands

incorporate powerful facilities to enable you to teach TMS-Pro to 

recognize and return only results which are of particular interest for your 

test. Details are given in the section on each individual command.

VALUE

Syntax: VALUE ({y}, {x}, x value, start time, finish time, occurrence)

Options: Name the result, assign the result to a variable, hide the result

Description: Returns the value of {y} at a given value of {x}, within a 

defined time range, for a given occurrence. It is this command that 

enables set points to be determined.  The section on multi-valued

functions discusses background to the development of the advanced 

features available with this command.

Example:

VALUE of displacement @ 300.0N (for occurrence 6, between load at 

40.000 sec and 50.000 sec)

Required Parameters: {x}, {y}, ‘x value’

Defaults: 'start time' - first point, 'finish time' - last point, ‘occurrence’ - 1

Restrictions: ‘start time’ and ‘finish time’ must be contained within the 

test data. If values of 'x value' and 'occurrence' mean that solution does not 

exist, then N/A will be returned as the answer. 

Output: Value {y} @ {x} {x units} = {result} {y units}

Note: if {x} is ‘time’, ‘occurrence’ must be ‘1’, ‘x value’ must be between 

‘Start time:’ and ‘Finish time:’, and 'Finish time:' must not be less than the 

'Start time:'

Example:

VALUE of time @ 46.9N (for occurrence 1, between load at Zero sec and 

End of test sec) means ‘look at all the data and return the time at which 

the load passed, for the first time, through 46.9 Newton.’ In the case of a 

dataset which is not monotonic, this may not be the result required, but 
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simply reflect the fact that the programmer has accepted the default values 

proposed for 'Start time:', 'Finish time:' and ‘Occurrence:’

The VALUE command can however be made much more selective, thus 

returning the value that is 'right' for the requirement of the particular test. 

For exam ple;  VALUE of time @ 46.9N (for occurrence 3, between load 

at 12.000 sec and  42.000 sec

means ‘return the time at which the load value passed through 46.9 

Newton for the third time, but do not start counting until the test has been 

running for 12 seconds, and if after 42 seconds it has not passed through 

that load for the third time, then do not return any result at all. 
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AVERAGE

Syntax: AVERAGE ({y}, {x}, start, finish)

Options: Name the result, assign the result to a variable, hide the result

Description: Average {y} value over given range of {x} values

Example:

AVERAGE load = f (time), from 30.000sec to 40.000sec

Required Parameters: {x}, {y}

Defaults: 'start' - first point 'finish' - last point

Restrictions: 'start' and 'finish' must exist

Output: Average {y} = {result} {y units}

Examples: 'AVERAGE displacement = f(time), from 13.000 sec to 17.000 

sec' means ‘return the average value of the displacement over the time 

period between 13sec and 17sec'.

SLOPE

Syntax: SLOPE ( {y}, {x}, start, finish)

Options: Name the result, assign the result to a variable, hide the result

Description: The gradient of {y} as a function of {x} within a defined 

range of {x} values, determined by two point linear interpolation. Note 

that this function calculates the slope of a line that has been constrained to 

pass through (or very close to) data points at the chosen 'start' and 'finish' 

values. The BEST-FIT function does not impose this constraint. 

Example:

SLOPE of displacement = f (time), from 3 min to 4 min
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Required Parameters: {y}, {x}

Defaults: 'start' - first point 'finish' - last point

Restrictions: 'start' and 'finish' must exist

Output: Slope = {result} {y/x units} 

Example:

SLOPE of load = f (displacement), from 2.00 mm to 3.00 mm

means ‘return the gradient of the load as a function of displacement for 

the straight line connecting data points at displacement values of 2mm 

and 3mm’. Such a command would be used when testing the hardness of 

various samples. The SLOPE command will take no notice of any of the 

data points between the two specified displacement values

BEST-FIT

Syntax: BEST-FIT ( {y}, {x}, start, finish)

Options: Name the result, assign the result to a variable, hide the result

Description: The gradient of {y} as a function of {x} within defined range 

of {x} values, determined by linear regression. Note that when 'y' is 

'stress' and 'x' is 'strain', this is called 'Young's Modulus'

Example: BEST-FIT to load = f(displacement), from 3 % to 40 %

Required Parameters: {y}, {x}

Defaults: 'start' - first point 'finish' - last point

Restrictions: 'start' and 'finish' must exist

Output: Best Fit Gradient = {result} {y/x units} 

Example:

BEST-FIT to load = f(displacement), from 19.05 mm to 25.40 mm

means ‘return the gradient of the load as a function of displacement for 

the data between the data points at displacement values of 19.05mm and 

25.40mm’. Such a command would be used to determine the stiffness of a 

sample when it is deformed by 6.35mm. The BEST-FIT command will 

regard each of the data points between the two specified displacement 

values as being of equal importance.
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Note that this is typical of how TMS-Pro will re-display a command 

which, although originally created using 'round' numbers of imperial 

units, is now being used by an operator who prefers to work with metric 

units.
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PEAK

Syntax: PEAK ({y}, {x}, start, finish, order, %)

Options: Name the result, assign the result to a variable, hide the result

Description: The maximum {y} value within a given range of {x} values, 

subject to other criteria enabling small peaks to be detected. The percent 

field allows the PEAK command to distinguish between small spikes that 

are a genuine signal, and background noise. If after the peak the y-value

does not fall by at least the selected percentage of the total range of y-

values, then that spike is not a genuine peak.

Example:

PEAK in load = f(time), between Initial sec and 400 sec, with order 5, 

condition = 6%

Required Parameters: {y}, {x}

Defaults: '%' – 10 'start' - first point  'finish' - last point  ‘order’ - 1 

Restrictions: 'start' and 'finish' must exist

Note: If you set the order parameter to:

0 - Finds the maximum peak within range (percentage does not matter)

1 - Finds first peak with a rise and drop that matches the percentage 

setting

2 - Finds second peak with a rise and drop that matches the percentage 

setting

3 - Finds third peak with a rise and drop that matches the percentage 

setting

Output: Peak {y} @ {x} {x units} = {result} {y units} 

Examples: A heat-sealed foil on a square plastic tray is being peeled and 

the peel force is being measured,

PEAK in load = f(displacement) between Initial mm and Final mm, with 

order of 0, condition = 10%

will simply return the maximum load whatever the percent condition. This 

is likely to be the load to initiate the peel (i.e. just before the broken bond 

begins to propagate) - which may not be the result required. 
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Let us assume that this initiation 'peak' always occurs at between 10 and 

11mm. If the peak when the bond break ‘turns the corner’ is required, 

then the initiation peak must be avoided, this could be achieved with the 

command

 PEAK in load = f(displacement) between 12.00 mm and Final mm, with 

order of 0, condition = 10%

This will ignore all data until the displacement reaches a value of 12mm, 

and then return the highest subsequent load value. It could also be 

returned by the command

 PEAK in load = f(displacement) between 12.00 mm and Final mm, with 

order of 1, condition = 10%

which will return the highest subsequent load peak. In reality it is unlikely 

that the bond break will reach both corners at the same time; there will 

probably be two secondary peaks, with the smaller of these two peaks 

appearing as a ‘shoulder’ on the larger. The command

 PEAK in load = f(displacement) between 12 and Final with order of 2, 

condition = 10%

may return the smaller of the two peaks. If however the two peaks are 

very close together, it may be necessary to experiment with smaller values

than '10' in one of the '%:' boxes.

If the initiation peak does not occur within a predictable displacement 

range, then, provided there is only one initiation peak, the commands 

'PEAK in load = f(displacement) between Initial mm and Final mm, with 

order of 2, condition =10%' and 'PEAK in load = f(displacement) between 

Initial and Final with order of 3' will return the two values required

Note: In the example above, although the PEAK command returns both 

the load and the displacement value of the peak to the Results screen, the 

x-co-ordinate (i.e. the displacement) is not included in a report. Similarly 

for the TROUGH command.

TROUGH

Syntax: TROUGH ({y}, {x}, start, finish, order, %)

Options: Name the result, assign the result to a variable, hide the result

Description: Minimum {y} value within a given range of {x} values, 

subject to other criteria enabling small troughs to be detected. The percent 

field allows the TROUGH command to distinguish between small dips 

which are a genuine signal, and background noise. If after the trough the 

signal does not climb by at least the selected percentage of the total range 

of y values, then that dip is not a genuine trough



Food Technology Corporation Texture Lab Pro Program Development • 31

Example:

TROUGH in load = f(displacement), between Initial in and 44.000 in, 

with order of 1, condition = 10%

Required Parameters: {y}, {x}

Defaults: '%' – 10, “start” – first point, “finish” - last point, “order” - 1

Restrictions: 'start' and 'finish' must exist.

Note: trough of order 0 will simply return the minimum value

Output: Trough {y} @ {x} {x units} = {result} {y units}

Example:

A compression test to evaluate the ‘tactile signature’ (i.e. the ‘feel’) of a 

PC mouse has been carried out. The displacement corresponding to the 

peak and trough on the actuation profile of the left and right buttons must 

be determined. The PEAK command enables each peak to be measured.

The command

 TROUGH in load = f(displacement), between Initial mm and Final mm, 

with order of 0, condition = 5%

will return the minimum value of load observed during the test - almost 

certainly zero! The required trough could, of course, be determined

manually after the test, but the command

 TROUGH in load = f(displacement) between Initial mm and Final mm, 

with order of 1, condition = 5%

will return the trough automatically, provided a reasonable value for the 

percent criterion, has been entered in to the '%:' box. 

Alternatively such a 'trial and error' technique for program development 

could be refined by using the command

TROUGH in load = f(displacement) between Initial and Final with order 

of 1, condition = V0%

in conjunction with an ENTER command which stores a dimensionless 

variable as 'V0'. Subsequently, when a reasonable value for the percent 

criterion has been identified, this can be programmed directly into the 

TROUGH command as a fixed value.

AREA

Syntax: AREA ({y}, {x}, start, finish)

Options: Name the result, assign the result to a variable, hide the result

Description: Area under test curve within a given range of {x} values



32 • Program Development Food Technology Corporation Texture Lab Pro

Example:

AREA under load = f(time), between 300 sec and 400 sec

Required Parameters: {y}, {x}

Defaults: 'start' - first point  'finish' - last point

Restrictions: 'start' and 'finish' must exist

Output: Area between {'start'} – {'finish'}{x units) = {result} {x*y units

When ‘x’ is ‘Newton’ and ‘y’ is ‘mm’ then the result will be described as 

'mill joules', or 'joules', if greater than 1J

Example:

AREA under load = f(displacement), from 56 mm to 78 mm 

means ‘return the area under the load versus displacement curve between 

deflections of 56mm and 78mm'. Note that, even if between some points 

in this range the load drops below zero, the area under this region of the 

curve is still considered to be positive, and will be added to the total area, 

i.e. this function returns the TOTAL energy exchange between the test

system and the sample.

VARIABLE

Syntax: VARIABLE (variable, text)

Description: Returns the value of a variable and its units, preceded by 

some explanatory text and a gap 

Example:

VARIABLE V1, value is Original Height of The Sample

Required Parameters: 'variable'

Defaults: 'text' – variable

Restrictions: No more than 50 characters in 'text'
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Output: {text} = {result} {units of variable}

Examples:

When a program is finished, the value of V5 is 34.5 N/mm, then the line

VARIABLE V5, value is The Burleigh coefficient means that, the

burleigh coefficient = 34.5 N/mm will be returned to the Results screen.

STEP

Syntax: STEP ({x}, {y}, from, to, %, occurrence)

Options: Name the result, assign the result to a variable, hide the result

Description: Detects / estimates the value of {x} when the value of {y} 

passes sharply from one steady value to another.

Example: STEP in event = f(displacement), between 0 and 1 @ 50%, for 

occurrence 2

Required Param eters: {x}, {y}, 'from', 'to'

Defaults: '%' - 50, 'occurrence' - 1 

Output: Step = {result} {x units} 

Note:

the STEP command differs in one fundamental respect from the VALUE, 

AVERAGE, AREA, SLOPE, BEST-FIT, PEAK, and TROUGH, 

commands. The STEP command requires two y values as input 

parameters. The other commands require an x value, or a range of x 

values, as input parameters. 

Example:

With a version of TMS-Pro in which the 'switch actuation' facility has 

been enabled, during a test, one column of the Data Matrix is 

accumulating blocks of (dimensionless) 0's and 1's. In Version 2 of TMS-

Pro the command

STEP in event = f(displacement), between 1 and 0 @ 50%, for occurrence 

3'

will allow return of the displacement at which a switch opens for the final 

time, assuming that it started off closed, but was switched off and then 

back on three times during the test
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KINK

Syntax: KINK ({y}, {x}, from, to, interval, occurrence)

Options: Name the result, assign the result to a variable, hide the result

Description: Detects / estimates the value of {x} when the slope of {y} as 

a function of {x} passes sharply from one steady value to another

The KINK command is generically similar to STEP, which detects a 

discontinuity - KINK detects a point of non-differentiability.

Example:

KINK in load = f(displacement), between Initial mm and 44.00 mm, with 

interval of 0.500 sec, for occurrence 2

Required Parameters: {x}, {y}, 'from', 'to', 'interval', 'occurrence' 

Defaults: 'from' - first point, 'to' - last point, 'interval' - 0.3s, 'occurrence' -

1

Restrictions: 'to' and 'from' must exist and 'interval' must be greater than 

0.01s

'Interval' is the time period over which each slope is calculated. Then 

TMS-Pro looks at the progressive change of these slope values, and 

decides whether any kinks have occurred.

Output: Kink = {result} {x units} 

Examples:

'KINK in displacement =f(load) between Initial N and Final N, with 

interval of 0.3sec, for occurrence 1' 

VERDICT

Syntax: VERDICT (minimum 'pass' value, maximum 'pass' value)

Description: Range of values for which the result of the calculation in the 

previous line can be considered to be a 'pass' or a 'fail'
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Required Parameters: ‘minimum 'pass' value’, ‘maximum 'pass' value’ 

Restrictions: This command cannot be the first calculation line. The 

values do not automatically change. If the previous line changes the 

minimum and maximum pass values must be changed manually. This will 

be necessary, for example, when units of measurement are changed. 

Output: The VERDICT command does not generate its own line in the 

Results screen, it modifies the appearance of the preceding line, see 

below.

Example: VERDICT for value in above line: between 10 and 20 is “pass”, 

else is “fail”

 The VERDICT command enables TMS-Pro to determine and display 

whether the sample being tested is within specification, or whether it has 

‘failed’ the test.

If the result of the Calculation command in the preceding line is less than 

10 or more than 20, that line will be printed in the Results screen in red. If 

the value is between 10 and 20 that line will be printed in the Results 

screen in green

DO-SUM

Syntax: DO-SUM (expression, units)

Options: Name the result, assign the result to a variable, hide the result

Description: Allows a test result or a variable to be operated upon 

mathematically after the test has been completed. 

Examples: DO-SUM (“Gumminess”) V5*6.2+ 3, Assign to V9, Show 

result

This would multiply the value of the variable V5 by 6.2 then add 3. The 

results would be called “Gumminess”, assigned to the variable V9 and the 

final value will be displayed in the results at the end of the test.
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Required Parameters: ‘expression’ and 'units' string

Note that for DO-SUM commands, TMS-Pro will ask for a 'units' string; 

just entering a [Space], is sufficient if no units string needs to be displayed 

in Results.

Restrictions:

'expression' must be a valid mathematical expression

'expression' must be free from dimensional conflict

'expression' string must not exceed 90 characters

'units' string must not exceed 15 characters.

The DO-SUM command allows variables to be operated upon 

mathematically, and the 'expression' is returned to the Results screen. It is 

similar to the FORMULA command, i.e. anything FORMULA can do 

during a test, DO-SUM can do after a test. The FORMULA command is 

restricted to calculating things that TMS-Pro can make use of during a 

test; the DO-SUM command is not

PRINT-WHEN

Syntax: PRINT-WHEN (parameter, condition, test value, true text, false

text)

Description: Applies a condition to value of a variable and returns text 

that depends on the result of the conditional test. The result from this 

command does not appear in reports.

Example: PRINT-WHEN V1 = 3 "Sample passed", else print "Sample

failed"

Required Parameters: 'parameter', 'condition', 'test value', 'true text'

Restrictions: Neither 'true text' nor 'false text' can exceed 40 characters. 

Output: {true text} OR {false text}
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TIME-STAMP

Syntax: TIME-STAMP

Description: At the moment before each test starts TMS-Pro reads and 

stores the internal calendar and clock values. This command will return 

these values to the Results screen. The result from this command does not 

appear in reports

Output: Test started at {time} on {date}

Example: A typical line returned to the Results screen would be:

Test Started at 11:49 on 3/9/02
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Toolbars

There are several toolbars that are displayed when entering an appropriate 

part of TMS-Pro.

Figure 3

The Standard toolbar just provides a “shortcut” to the features of TMS-

Pro that are likely to be used most frequently. Most of the features of this 

toolbar can be accessed by choosing appropriate options from the Menu

Bar Therefore the toolbar can be toggled on and off by choosing Toolbars 

option from Display menu.

1 New Button (The same as selecting New Option from File menu)

2 Open Button (The same as selecting Open Option from File menu)

3 Save Button (The same as selecting Save Option from File menu)

4 Copy Graph Button (The same as selecting Copy Graph Option from 

Display menu) 

5 Print Button (The same as selecting Print Option from File menu, then 

clicking on OK)

6 Display Graph Button (The same as selecting Graph Option from 

Display menu)

7 Results Button (The same as selecting Results Option from Test menu)

8 Replay Button (The same as selecting Replay Option from Display 

menu)

9 Help Topics Button. (The same as selecting Help Topics Option from 

Help menu)

If two or more tests have been run, the following 2 buttons will be active

10 Review Previous Test Button

11 Review Next Test Button
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12 Delete Test Sample Button

The Load/Displacement toolbar provides facilities that are particularly 

convenient when tests are being set-up or carried out. The toolbar, which 

is not essential for running tests, can be toggled on and off by choosing 

Toolbars option from Display menu. 

When the system is in limited functionality mode the toolbar can serve no 

useful purpose and is therefore disabled. Neither does the toolbar serve 

any purpose in the Graph screen or the Replay screen; therefore, within 

these screens, it is never displayed.

13 Zero Load Button –Tares the weight of any load on the load cell

14 Restore Load Button – Removes the tare 

15 Zero Displacement Button – Sets the current position to zero

16 Restore Displacement Button – Restores the zero position to the 

previous value 

17 Park Button – Move the cross head to the Zero position
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Menus

File Menu Commands

New

Choosing from File menu will remove any current test program / data. A 

warning message will be displayed before erasing any unsaved data. 

Open

Choosing Open option will display the files in TMS-Pro format which are 

in the folder that was most recently accessed by TMS-Pro. Only files in 

TMS-Pro format can be opened by this command. If the file required has 

been used recently, then using the List of Files feature, in the File Menu, 

may be a more convenient way to load the required file.

It is possible that the file being opened will make use of features that are 

beyond the capabilities of your particular test system. Under these 

circumstances TMS-Pro will display a warning message and advise 

running the program de-bug facility. The operator will be allowed limited 

access to the test program, but it will not be possible to run a test. 

Features that will trigger such a warning are either, a load greater than the 

capacity of the load cell, or an auxiliary input which your software cannot 

process.

Save

Choosing Save option will save the current test program and all current

data, using the existing test file name. The file will remain open so that 

you can continue to work on it.

TMS-Pro will save the program Samples with a filename “Samples.for”. 

This “force test file” will not just contain information about the test 

procedure and calculations, it will also contain:

1. Any information about the particular test sample(s) - such as size, lot 

number, or operator comments. 
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2. Information about preferred units of measure and whether the test is in 

tension or compression.

3. Information about the presentation of data - such as graph titles, axis 

labels and maximum values of graph axes.

4. Information specifying the reporting format, batch size, for example.

5. The test data for all the samples in the report or batch.

To save only a test procedure with the associated calculations and 

preferences, but not any data, use the Save Library Program command

Save As 

Choosing Save As will enable the current test program, calculations and 

data to be saved using a file name selected by the operator. This command 

can be used either to name a new data file, or save an existing data file 

under a new name while leaving the original data file unchanged. The file 

will remain open so you can continue working with it. If you wish to save 

your file to a folder different from the one which TMS-Pro suggests in the 

“Save in:” text box, click on the drop-down arrow to the right of that box, 

select the appropriate folder, type the file name of your choice in the “File 

name:” text box, then click on Save button. 

Cut, Compress and Crop: The high data acquisition rate which TMS-Pro -

based systems deliver means that data files can be very large. TMS-Pro

does therefore incorporate “Cut”, “Compress” and “Crop” features that 

allow data to be saved as smaller files. To save a portion of the original 

data, click the Compress button and a dialog box, giving the number of 

data points in the data file, will be displayed. Click on the up/down arrows 

to the right of the “Compress by:” box until the appropriate integer 

number (between 2 and 100) appears in that box; then click on the Save 

button.

Note: after a test, the Compress feature can be used to “de-tune” the 

performance delivered by TMS-Pro, and enable more direct comparison 

with data archived by earlier generation testing software. If there are 6000 

data points in the original file, “Compress by 4” will throw away 3 out of 

4 points and there will be 1500 points in the modified file.

To re-scale the data file to a given number of data points, click the Cut 

button and a dialog box, giving the number of data points in the data file, 

will be displayed. Click on the up/down arrows to the right of the “Cut 

to:” box until the number of data points required in the modified file 

(probably a nice round number) appears in that box; then click on the 

Save button. The “Cut” feature does involve calculating data points by 

linear interpolation, but it can only decrease the number of data points 

stored. Note that some points would not actually have existed in the 

original test.
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Under some circumstances, it is much more useful to retain all the data 

points from just part of a test. Click on the Crop button, then click on the 

up/down arrows to the right of the “Start time:” box until the appropriate 

time appears, then click on the up/down arrows to the right of the “Finish 

time:” box until the appropriate time appears; then click on the Save 

button. It may be necessary to examine the original data, before suitable 

Start and Finish times can be identified.

Note: if cut, cropped, or compressed data are saved using the same file 

name as the original data then it will not be possible to recover all of the 

original data. Therefore, it may be useful to save such data using a new 

file name.

It will not always be appropriate for data for each sample to be 

compressed, cut or cropped in exactly the same manner. Data can be 

cropped to a suitable time range for individual samples by choosing the 

“Individual” option from “Save Setup” combo box, clicking on the 

appropriate sample, clicking in “Crop”, entering the appropriate time 

range, clicking on any other sample, and finally clicking on Save.

To save only a test procedure with the associated calculations and 

preferences, but not any data at all, use the Save Library Program 

command

Load Library Program 

Choosing Load Library Program option will display the library files in 

TMS-Pros Library folder. Select the required library file by clicking on it,

then click on Open button. If you wish to load a file from another folder, 

click on the drop-down arrow to the right of the “Look In:” box, select the 

appropriate folder, select the appropriate file, then click on Open button. 

Save Library Program

Choosing Save Library Program will save the current test program, 

calculations, preferences, and (if appropriate) report parameters; however 

no test data or notes will be saved. The file will remain open so that you 

can continue to work on it. TMS-Pro will try to save the program 

“Samples” with a filename “Samples.lif”. If a library file with this name 

already exists, a warning will be displayed before the file is overwritten. 

Clicking on Yes will overwrite the existing library file, but clicking on No 

will enable the file to be saved with a new name and/or path.

When a test program has been saved as a library program (in *.lif format), 

but before it has been saved as a test file (in *.for format) the colored title 

bar at the top of the window will describe the program as “Untitled”. 

Although choosing either Program or Calculations option from Test menu 

will display a dialog box with the library filenam e in the title bar, that will 

not of course be permanently displayed. It is therefore recommended that, 

before saving a library program, the programmer selects Settings option 

from Display menu and types a description into the “Graph Title:” box.
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Print Summary

Selecting Print Summary, will print a pre-formatted “executive summary” 

onto one sheet of paper. The summary includes the information in Notes

,a graph of the test data and the calculated test results. It will display the 

dialog box to set-up your printing preferences. Windows may be aware of 

more than one available printer. If a different printer from the one 

appearing in the “Name:” text box is required, click on the dropdown 

arrow to the right of that box, select the appropriate printer, then click on 

OK button. 

Print Set-up

Choosing Print Set-up will display the dialog box that will set-up your 

printing preferences. Windows may be aware of more than one available 

printer. If a different printer from the one appearing in the “Name:” text 

box is required, click on the dropdown arrow to the right of that box, 

select the appropriate printer, and then click on OK button. The 

Orientation is likely to be set to “Portrait”, because most popular software 

applications are more likely to need printouts of this type. Printouts of 

TMS-Pro graphs do however look better in Landscape format so it may be 

better to change this setting. The “Paper, Size:” setting should reflect the 

paper which is loaded into your printer. Once your printing has been set-

up, just click on the printer icon in the Standard toolbar to print

Print Preview

Choosing Print Preview will display an image of the way the sheet(s) of 

paper in your printer will appear if you were to click on Print button. To 

increase the magnification of the pre-viewed image click (once or twice) 

on the Zoom In button. To decrease the magnification of the previewed 

image click (once or twice) on the Zoom Out button. To print directly 

from the Print Preview facility click on the Print button. Click Close to 

return to TMS-Pro.

Print

Choosing Print will display the dialog box that will set-up your printing 

preferences. Windows may be aware of more than one available printer. If 

a different printer from the one appearing in the “Name:” text box is 

required, click on the dropdown arrow to the right of that box, select the 

appropriate printer, then click on OK button. Once your printing has been 

set-up, just click on the printer icon in the Standard tool bar to print

Export

TMS-Pro incorporates a comprehensive range of calculation facilities and 

tools for customizing calculations to the testing requirements of individual 

users. However, no software can cover all calculations for every possible 

application. The Export command enables data accumulated by TMS-Pro

to be exported to other PC software packages, where more calculations 

can be made. TMS-Pro’s high data acquisition rate means that data files 

can be very large so, the Export command offers a dialogue box which 

incorporates “Cut”, “Compress” and “Crop” features.
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Click on the OK button to enter the Export Settings dialogue box. This 

allows the delimiter to be chosen, the options are “Tab” or “Comma”. The 

operator can choose how many columns of data are in the exported file; 

normally three columns would be exported by selecting “Force”, 

Distance” and “Time” from the “Fields” list. However when secondary 

data are available up five fields can be selected, and when a reference file 

(for use with the Tolerance Band feature) is being created just the two 

appropriate fields should be chosen.

It can also be useful occasionally to “pick out” just a few individual data 

points to be displayed within another software application. This can be 

done by entering TMS-Pro’s display data facility, then using the Copy 

button to send data to the clipboard.

Recent File List

Clicking on File offers a menu with eleven items. The tenth item is a list 

of the most recently used files. Selecting the name of any of these files 

will load the selected file. There will be up to eight files on this list.

Exit

Clicking on Exit will (after terminating all operation of the associated test 

stand and displaying a warning if any test data have not been saved) 

return to the Windows desktop.
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Test Menu Commands

Notes

Before printing a test summary, it will be necessary to choose Notes 

option from Test menu. This will display a dialog box with a number of 

text boxes. The following information should be entered:

Type a sample number or description in the “Specimen”: box.

Type a batch number or code in the “Batch:” box.

The current date will appear automatically in the “Date:” box.

The operator of the test series on the “Operator:” box.

The final box allows free typing of further information, such as test 

description.

This dialog box can be re-visited and the notes can be updated, at any 

time. Note that it is the date of most recent modification that is recorded 

here. It is also possible to archive the precise date and time that a test was 

carried out by using the TIME-STAMP command.

Program

Choosing Program will display a dialog box that enables test programs to 

be written and edited. The layout and features of this dialog box are 

described in the section on program development. It is the details of each

program command which are described here. This option is only available 

to master access

Calculations

Choosing Calculations option from Test menu will display the dialog box 

that will enable the calculations to be made with the test data to be 

specified. The results of these calculations will be displayed in the Results

screen. This option is only available to master access

Results

Choosing Results option from Test menu will display a dialog box with

two “card index tabs” at the top of this screen, one labeled “Results” and 

the other labeled “Report”. “Results” is the default, when this is chosen 

the results from all the calculations specified will be displayed. There may 

be too many results to fit , in which case use the scroll bar on the right to 

display the result(s) of particular interest.

To print all of the results for one sample, click on the Print current results 

button. Similarly, to print all of the results for all of the samples in the 

file, click on the Print results for all samples button. In both cases it is 

possible to print only some of the results, by using the technique of 

cutting and pasting. Selected results can then be pasted to other software 

and printed from there. Similarly the results could be Emailed to a 
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colleague by pasting into your Email software, or processed 

mathematically by pasting into a spreadsheet.

If results for more than one sample are available, choose the appropriate 

sample by clicking on the up/down arrows to the right of the “Sample 

Number:” box.

Clicking on the Report tab will bring to the front the screen where batch 

reporting and writing results to an open report can be controlled.

Reports are saved in a format that can easily be imported into most other 

software packages. This format uses a “comma” as the delimiter. 

Whenever a report is opened, TMS-Pro will automatically give the report 

a name, unless the operator has checked the “Specify filename for report”

box and entered an appropriate name. 

An inconvenience of using such a universal format for report files is that 

TMS-Pro may be denied access to a report, because that report is “open” 

within another software package - Notepad or Excel, for example. 

Operators should avoid using another software package to open a report 

while TMS-Pro is still being used to complete the report - because the 

report file will “locked” when TMS-Pro tries to read or update it. The 

error messages “Failed to create/open report file”, or “Failed to open 

results report file” indicate that a report is “locked”

If the “Batch Size:” box is left blank, when entering the first record, 

clicking on the Add to Report button will increment the contents of the 

“Records in Report:” box from “0” to “1” – from this point onward the 

associated report will be open-ended, the arrows for adjusting batch size 

will become disabled and data can be added “ad infinitum”. Data from the 

report can be browsed or printed at any time by clicking on the View 

Report or Print Report button respectively Once open reporting has been 

specified for a test file, the file will need to be saved under a new name 

before a batch report can be accumulated.

Batch Reporting

Once the “Batch size:” is set to a value, and the first record has been 

added to the new batch report, the View Report, Print Report, and arrows 

for adjusting batch size will become disabled. Further records can be 

added to the batch report by clicking on the Add to Report button – until 

the “Records in Report:” is equal to the “Batch Size:” – the batch test has 

now been completed. Once a full set of batch data has been completed:

The Add to Report button will become disabled. The View Report and 

Print Report buttons will become enabled. Clicking on View Report or 

Print Report button will respectively display or print both the results for 

each sample and the batch statistics for each result. Batch statistics” 

means the mean and standard deviation for each result.

It will only be possible to store more batch data, by setting up a new batch 

report. If, for example, the batch test “WIDGET18.for” has been 

completed, re-load the appropriate library program by selecting Load 

Library Program option from the File menu. Then, when the first test has 

been completed and the batch size has been set, select Save As option 

from File menu, and type “WIDGET19” in the “File Name:” text box. It 

will be possible to decide not to store the new data in batch report format, 

simply by not entering a value into “Batch size”.
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Every report file knows the name of the “parent” test data file from which 

it was created. If the name of the “parent” data file is changed, the 

currently open “daughter” report file will be updated. It is strongly 

recommended that a batch report file is not completed before saving the 

data from the “parent” file – otherwise (whatever may happen in the 

future) the report file will become an “orphan”, believing that it was 

created by a data file called “untitled.for”.

The fact that ever report file remembers the nam e of the “parent” data file, 

also means that TMS-Pro can detect, and reject, an attempt to add data to 

a report which is not a “daughter” of the active data file. The message 

“The selected report file is not compatible with the current data file, 

choose another report file” will be displayed. 

Similarly, every test data file knows the path to the current “daughter” 

report file. If, before the report has been completed, the report file is 

moved, or re-named TMS-Pro cannot update it. Also if TMS-Pro detects 

that the report file has been “corrupted” by being written to by other 

software, it will make no attempt to update it.

When a batch report has been completed, and one further test has been 

carried out, TMS-Pro will, if automatic reporting is active, display the 

prompt “Batch report completed. Start another similar report? [Yes] 

[No]”. It is important to remember that, if the completed report was 

opened for inspection, it should have been closed down before the testing 

continued, otherwise the above message cannot be displayed. Choosing 

the “Yes” option will display the Report screen with the settings of the 

previous report proposed, but choosing the “No” option will display the 

Report screen with no settings proposed. TMS-Pro cannot detect that the 

previous report is “full”, if that report is locked.

Automatic Reporting

The default setting of TMS-Pro means that data will not be added to an

open report or a batch report until the Add to Report button is clicked. It 

may be useful on some occasions to ensure that data from every 

completed test are reported – whether or not the operator likes the look of 

them. This will occur if the “Auto-add data from completed tests:” 

checkbox (in the Report dialog box) is enabled. “Master” access is 

required to change the setting of “Auto-add data from completed test(s)” 

checkbox.

If the operator checks the “Auto-add data from completed tests:” box, data 

for every sample tested within the current file will be added to the report 

the next time the Add to Report button is clicked. Subsequently, whenever 

a test is completed, data for the new test will automatically be added to 

the report. If the number of samples exceeds the batch size, TMS-Pro will 

automatically make the report “open” rather than “batch”

Interrupted Reporting

While a report is still in the process of being completed, if TMS-Pro is 

closed down, the message “The results file has been modified do you wish 

to save changes before closing TMS-Pro? [Yes][No]” may appear, under 

these circumstances the Yes option should be chosen. This will ensure 

that test data file is updated and enable TMS-Pro to “keep track of” the 

report file being compiled
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Until the Save As or Save option is chosen from the File menu, storage of 

test data is volatile because it is in RAM. If TMS-Pro is closed down by 

an interruption to the power supply, there is unfortunately nothing that can 

be done to prevent any unsaved test data from being lost. However, 

because reports are updated to non-volatile storage immediately after a 

test is completed if automatic reporting is active, test results associated 

with the lost test data will not be lost. TMS-Pro may however have lost 

track of the name, path and status of the test report. Therefore after re-

booting TMS-Pro, and reloading the test data file, the recommended 

procedure is to choose the Results option from the Test menu, click on the 

Report tab, and, if necessary, Browse for the appropriate test report; the 

Report dialog box will then be updated, and testing / reporting can 

continue. Storage of report data is also non-volatile when clicking on the 

Add to Report button

Reporting Calculation Changes

If, with a report only partially completed, a new calculation is added to 

the “parent” *.for file no immediate change is made to the “daughter” 

report. If another test is carried out, when the results of the new test are 

added to the report, the results for all the records within the report are 

updated to include the new calculation. 

It should however be noted that a “parent” test data file could have more 

than one “daughter” report file. When calculation changes are introduced, 

only the currently open batch report file will be automatically updated 

when a new record is saved.

Display Menu Commands

Graph

TMS-Pro will enter the Graph screen when Graph option from Test menu 

is chosen. The Graph toolbar will be displayed, and the Sample toolbar

will be displayed if results for more than one test sample are available.

Figure 4: Test Sample Selection Toolbar

1. Previous Test Sample button

2. Jump to a Sample

3. Next Test Sample button

4. Delete the currently selected sample

If two or more tests have been run, the above toolbar will be available. 

When a number of samples have been tested, but data for only one sample 
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can be displayed, this allows a particular sample to be chosen. A counter 

indicating the number of the sample selected (and the total number of 

samples tested) is displayed in the Status Bar. The Overlays command can 

be used to display data for more than one sample

Two buttons on the Graph toolbar allow the graph to be re-drawn:

Preferences & Zoom

The remaining three options allow interrogation of the test data: Cursor 

Drop, Timeline and Review Results Note: These features can be accessed 

directly from Display menu, by selecting Interrogate option.

Figure 5: Graph Toolbar

1. Graph Settings Button 

2. Zoom Button

3. Cursor-drop Button

4. Timeline Button

5. Review / Display Results Button

The Graph toolbar is displayed automatically when entering the Graph 

screen.

Settings

This dialog box allows the appearance of the graph to be customized and 

can be accessed from different parts of TMS-Pro. Details of the facilities 

available are given within the section on the Graph command.

Overlays

Choosing Overlays option from Display menu will display a dialog box 

that will allow data from more than just one graph to be plotted. This 

option is only available to master access. There are three radio buttons at 

the top of this dialog box: “Neither”, “Multiple Traces”, and “Tolerance 

Band”. The default is “Neither”, and in this case, all other facilities within 

the dialog box (apart from OK and Cancel) are disabled. This setting 

means that data for a single sample will be displayed on the graph.

Displaying the Sample toolbar will automatically re-set Overlays to 

“Neither”

The Sample toolbar determines the single sample for which data will be 

plotted.
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Multiple Traces Option

Selecting the “Multiple Traces” option makes the Sample(s) list on the 

left -hand side of the dialog box available - the list appears in black rather 

than grey. It is now possible to plot up to eight graphs concurrently by 

clicking on the appropriate samples. If a new test is started, and if fewer 

than seven test traces are already plotted, data for the new test will be 

plotted in addition to data for the existing test traces.

Tolerance Band Option

Selecting “Tolerance Band” option makes the Tolerance Band options 

panel available. This feature will allow your test data to be compared with 

data for a reference sample. TMS-Pro will need to know the path to the 

file that contains the reference data. This can either be found by using the 

Browse button, or it can be typed directly into the “Reference File” box. 

The data in this reference file must be available either as a tab-delimited

or comma-delimited text file – called “reference.txt”, perhaps. This could 

have been produced within a spreadsheet by generating theoretical data, or 

by exporting real data from an ideal sample, or by averaging the exported

data from several typical samples. The easiest way to create a reference 

file, is to minimize noise with the sampling rate facility, then export the 

data, after cutting to no more than 100 points.

There must be only two columns in the reference text file, with the data to 

be plotted on the y-axis being in the first column. The data for the first 

data point should appear in the third row, the data for the second data 

point should be in the forth row, etc.… Text strings giving the units of the 

data following should appear in the second row.

TMS-Pro will generally configure itself automatically to respond to the 

units of measurement which are preferred by the operator. However, in 

the particular case of tolerance bands, TMS-Pro will, for example, reject a 

reference file with load data in Newton, if the displayed test data are in 

kgf or lbf. Under these circumstances the operator must either: Change the 

units in which the test data are displayed, by using the preferences facility, 

or arrange for a new reference file to be generated.

Two types of tolerance bands can be generated. Typing a number into the 

“Factor” box (20%, for example) will generate a factor-based tolerance 

band:

A factor tolerance band: the data in the reference file are shown in red, 

and the tolerance limits that will appear on the graph are shown in green.
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Typing a number into the “Difference” box (5 Newton, for example) will 

generate a difference-based tolerance band:

A difference tolerance band: Please note that tolerance bands are 

calculated on the basis of there being an acceptable range of values for the 

parameter plotted on the y-axis. If, for example, data have been plotted as 

Load/Displacement, but you need to work with a specification that 

requires test data to be within ± 5mm of the data for a reference sample, 

then use the “Others” option in the graph settings facility to generate a 

Displacement/Load plot.

It can sometimes be awkward to devise the calculation(s) necessary to 

detect when a sample is not within tolerance. TMS-Pro therefore has the 

facility to do this automatically. Clicking in the “Display Tolerance Alert” 

checkbox, will ensure that, when appropriate,  a warning will appear in the 

Results screen. Data which “fail” (i.e. fall outside the y-axis limits of the 

tolerance band) will be plotted in red, but data which “pass” (i.e. fall 

within the y-axis limits of the tolerance band) will be plotted in green. 

Data that fall outside the x-axis limits of the tolerance band) will be 

plotted in black.

Data

Choosing Data option from Display menu will display a dialog box that 

presents the test data as a table. This will allow the test data to be 

inspected, if required. The high data acquisition rate delivered by TMS-

Pro -based systems does however mean that there will probably be many 

data points to display. Consequently, the operator will need to drag the

vertical scroll bar down to the region of interest.

If the duration of a test is more than 16secs, then TMS-Pro can only make 

values available to the Data command in discrete blocks. If the Next 

button is enabled, then even dragging the vertical scroll bar down to the 

bottom of its travel limit will not display all the stored data. Under these 

circumstances, using the Next or Previous buttons to select the 

appropriate data block, will enable the scroll bar to be used to display 

those data points which are of particular interest. This table will usually 

have three columns, unless TMS-Pros auxiliary or event input modules 

are available.

There is no button that will simply print out all the test data. It may be 

necessary however to select a limited number of data points to be included 
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within a document or spreadsheet. This can be achieved either by left 

clicking on the first data point in the desired range, then holding down 

Shift and clicking on the last data point in that range, or by holding down 

Ctrl and clicking on each data point individually. When the required data 

have been selected, either clicking on Copy, or right clicking, will save 

the selected data points to the clipboard; the data can from there be taken 

into other Widows software by cutting and pasting. The data can then be 

printed from this other software package. If data need to be systematically 

cut, cropped or compressed before being displayed within another 

software application, this can be done efficiently by using TMS-Pro “s 

export facility.

Replay

TMS-Pro will display the Replay screen when Replay option from Test 

menu is chosen. The Replay toolbar will be available, and the Sample 

toolbar will be displayed if results for more than one test sample are 

available.

Figure 6: Replay Toolbar

1. The Fast Forward button

2. The Play button

3. The Return to Start button

4. The Stop button

5. The Exit button

The Replay toolbar is displayed automatically when entering the Replay 

screen.

Clicking on the Play button in the Replay Toolbar will replay the test data 

in real-time. During replay, clicking on the Fast Forward button will 

increase the speed of replay by a factor of ten. When replaying data in 

Fast Forward mode, re-clicking on the Play button will resume data replay 

at normal speed. During replay, clicking on the Return to Start button will 

clear all plotted data from the display and automatically replay data from 

the start of the test. Clicking on the Stop button will stop further data

being plotted – until the operator re-clicks on Play. Clicking on the Exit 

button of the Replay Toolbar re-displays the main programmed testing 

screen.

When the current test file contains data for more than one sample, the 

Sample Toolbar determines the sample for which data will be replayed; 

the sample counter is displayed on the Status Bar.

When TMS-Pro is replaying test data, a slider at the bottom of the screen 

moves from left to right to indicate the fraction of the available test data 

that has been plotted. It is possible to jump to any particular stage of the 

test by slowly dragging the slider to a new position.
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Language

Choosing Language option from Display menu will display a dialog box

which enables the user to choose which language TMS-Pro and the 

associated Help system will operate in; choosing from a list of up to three 

languages is possible. TMS-Pro will translate all text messages, but it will 

make no attempt to translate Program  or Calculation commands or any 

variable.

Copy Graph

Choosing the Copy Graph option from Test menu enables an TMS-Pro

graph to be copied to the clipboard. The graph can then be incorporated 

into other software packages by using the Paste button in the target 

software.

When TMS-Pro is in the Graph screen, clicking on the right-hand mouse 

button and selecting the Copy Graph option from the menu displayed will 

also export a graph to the clipboard. Note that information superimposed 

onto the graph with the Cursor Drop, Timeline, or Review Results tools 

will not be copied to the clipboard. A printout of a displayed graph 

(original or annotated) can however be generated by choosing Print option 

from File menu, or by clicking on the Print button in the Standard toolbar.

Interrogate

This allows direct access to the facilities for graphically interrogating the 

test data: Cursor Drop, Timeline,  Review Results etc.

Summary View 

Selecting Summary View displays the test results in a window under the 

tool bars. All of the current results as the accumulated statistics are 

displayed. The widow can be sized to display as much of the data as 

desired. If the window is too small to display all the data, a scroll bar is 

positioned to the right side of the window.

Toolbars

The operator can, by choosing Toolbars option from Display menu, 

determine whether the Standard toolbar and/or the Load / Displacement 

toolbar will be displayed. Within the dropdown Display, Toolbars menu, a 

tick next to the command indicates that the toolbar is active. TMS-Pro

will automatically display the Graph toolbar, the Sample toolbar, and the 

Replay toolbar when appropriate.

Status Bar

The operator can, by clicking on the Status Bar option from Display 

menu, determine whether the status bar will appear at the bottom of the 

screen. A tick next to the command indicates that the status bar will be 

displayed. The Status Bar provides,  the following items of information:
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The cycle number, and total number of cycles – when a CYCLE

command is being executed. 

The “zoom level” – when a zoomed graph is being displayed. 

The sample counter and the total number of samples – when there is more 

than one sample in the file.

The x and y co-ordinates of the position of the cursor – when the cursor is 

in part of the screen used for displaying graphs.

Settings

Clicking on the Settings button on the Graph toolbar will display a dialog 

box that will allow the parameters which determine the layout of a graph 

to be selected and stored. This option is available to operator access, 

although Setup, Preferences is not.

Under most circumstances the data plotted will be:

Load on the Y-axis versus displacement on the X-axis

Load on the Y-axis versus time on the X-axis

Displacement on the Y-axis versus time on the X-axis

Each of these axis pairings can be chosen by selecting the appropriate 

radio button.

When TMS-Pro has extra facilities for measuring, logging and plotting 

secondary data, i.e. from the auxiliary input or the event input, then some 

other axis pairings will be need to be available. This can be achieved by 

selecting the “Others” option, which will enable the dropdown lists 

associated with “Y-Axis” and “X-Axis”. Click on the [Down arrow] to the 

right of the “Y-Axis” box, and choose from the list of primary and 

secondary data parameters displayed. Then click on the [Down arrow] to 

the right of the “X-Axis” box, and choose from the list of primary and 

secondary data parameters that remain available. Even if secondary data 

facilities are not available, an operator might occasionally feel the need to 

plot time on the Y-axis.

Clicking on the Display accumulative displacement box causes the graph 

to be drawn with the movem ent on the x axis always in a positive 

direction.

Titles and Ranges: When a graph is printed out, the text which appears at 

the top of that printout is determined by what is typed into the “Graph 

Title:” text box. Similarly the text which is printed parallel to the x-axis

and the y-axis is determined by what is typed into the “X-Axis, Graph 

Title:” the “Y-Axis, Graph Title:” text boxes respectively. The range of 

data which is plotted on both the x and y axes of the graph is determined 

by the values which are typed into the appropriate “Minimum:” and 

“Maximum:” text boxes. Within TMS-Pro “limit” means what is allowed 

during a test, while “range” means what is displayed after a test.
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Other Features

Activating the “Legends” checkbox will only affect the printout of a 

graph if the “Multiple Traces” option has been selected in the Overlays

dialog box. Under these circumstances, a key to which trace is associated 

with each sample will appear under the printed graph.

When there is no tick in the “Grid lines” checkbox, the trace will be 

plotted on a plain white background. Activating this checkbox will result 

in the trace appearing to be plotted on graph paper.

If the “Auto-scale” checkbox is activated, when the graph is re-plotted,

the maxima and minima of both axes will be automatically adjusted to 

precisely “fit” the data.

With multi-sample data, axes are adjusted to accommodate data for all 

samples

Zoom

Click on the Zoom button on the Graph toolbar to activate the multi-level

zoom facility. Define one corner of the zoom box, by moving the cursor 

into the graph area, clicking on the left -hand mouse button, and holding it 

down. As the cursor is moved across the graph area, a rectangle 

representing the zoom box will be drawn on the graph. The opposite 

corner of the zoom box will be defined by the position of the cursor when 

the left -hand mouse button is released; the graph will be re-drawn to the 

limits defined by the zoom box.

To “undo” a zoom operation, click on the right-hand mouse button and 

select the Zoom Out option from the displayed menu.

Four levels of zoom are available, (i.e. it is possible to magnify a small 

area of the graph by zooming in up to four times concurrently.) The zoom 

level is displayed on the Status Bar

Cursor Drop

Click on the Cursor Drop button on the Graph toolbar to activate the 

cursor drop facility. Drag the cursor into the graph area – the “normal” 

cursor will change to a “cross hair” cursor. Move this cursor to a point on 

the graph that is of particular interest, then click on the left -hand mouse 

button. TMS-Pro will “remember” the co-ordinates of this point which 

will be connected by a lilac line to the current cursor position. Left -

clicking again will “drop” the cursor and display a box containing the co-

ordinates of the dropped cursor.

The box can be moved or deleted by clicking on the right-hand mouse 

button and selecting either Move Box or Remove Cursor Drop. User-

defined text can be added to the box by selecting the Add/Edit Caption

option from the menu that is displayed, and typing in the required caption 

or modifying the existing caption. Note that only one line of text can be 

added.
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Timeline

Click on the Timeline button on the Graph toolbar. A single slider beneath 

the graph area indicates that timeline facility is active. Move the cursor 

over the pointer on the slider, click and hold down the left -hand mouse 

button, and drag the pointer to another position. Note that the data in the 

value boxes above the graph change, and that a vertical black marker line 

appears on the graph.  To display the data at the start of the test, drag the 

pointer to the left -hand limit of the slider. Similarly, to display the data at 

the end of the test, drag the pointer to the right hand limit of the slider.

Note that the marker line can only remain vertically aligned with the 

pointer if: the x axis displays “time”, and the maximum limit of the x axis 

is set (in Preferences) to the duration of the test.

The Timeline, in effect, enables an operator to “graphically interrogate” 

the test data. It would, of course, be possible to select the Data option

from the Display menu, and identify the particular row of values that have 

produced each interesting feature on the test curve. It is however much 

more convenient to drag the Timeline pointer until the marker line points 

at each interesting feature.

Review Results

The test calculations can be “graphically interrogated” by clicking on the 

Review Results button on the Graph toolbar. A double slider beneath the 

graph area indicates that the review results facility is active. The result of 

the first calculation is displayed, and the point, line or area corresponding 

to this calculation is superimposed on the graph. Clicking on the Next 

Result button will display the result of the second calculation.

Some calculations can be more precisely defined by specifying a range of 

values. Consider the AVERAGE command. The example given asked for 

the average value of the displacement to be calculated between 13 and 17 

seconds. When the result for this calculation is displayed (with suitable 

preference settings) within Review Results, two vertical black marker 

lines at 13 and 17 seconds will be superimposed on the graph. The 

operator may need to “fine tune” the range which was originally specified.

Each marker line corresponds to a slider below the graph, and either 

marker line can be re-positioned by dragging the pointer on the 

appropriate slider.

When markers are repositioned not only are calculations updated and re-

displayed, the range values in the corresponding calculation command are 

also updated, i.e. the test program will have been changed. Consequently 

when closing the TMS-Pro “force file” (*.for) the operator will be warned 

that the program has changed, and asked if the changes should be saved.

The Review Results facility enables an operator to refine a program 

calculation “with the benefit of hindsight”
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Any corresponding TMS-Pro “library file” (*.lif) will not however be 

changed automatically



Food Technology Corporation Texture Lab Pro Menus • 59

Set-up Menu Commands

Preferences

Choosing Preferences option from Set-up menu will display a dialog box 

with three tab options. “General” is the default. This will allow selection 

and storage of: units of measurement, acceptable range of each unit, and 

the sign convention for load (i.e. “tension” or “compression”). 

Selecting the “Graph Settings” tab reproduces the effect of selecting 

Graph option from Display menu, then clicking on the Preferences button 

on the Graph toolbar. This option is only available to master access 

Selecting the Automate tab allows the user to select the “Return to zero 

displacement” box.  This feature makes the TMS-Pro return to the last 

point of position that the displacement was zeroed to, aft er the completion 

of each test.

General

The “Units” group of drop down list boxes enables force units, 

displacement units, and time units to be selected. When preferred force, 

displacement and time units have been selected, clicking on the Save as 

Defaults button ensures that TMS-Pro will in future boot up in, and 

operate with, the units chosen.

Tension or Compression

Whether the “Tension” or “Compression” option is chosen has a 

fundamental effect upon:

1. The direction of movement of the crosshead when a test starts

2. What sign appears on load and displacement values measured during a 

test

3. Whether, when a program  is being developed, a minus sign needs to be 

entered before each value of load, displacement or speed.

When the “Tension” option is chosen:

“4.59N” will be a tensile load

“-4.59N” will be compressive load

“23.7mm” will be a displacement above the zero position

“-23.7mm” will be a displacement below the zero position

The program command “RUN @ 75mm/min until time = 5.000sec” 
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Will move the crosshead up

The program command “RUN @ -75mm/min until time = 5.000sec” 

Will move the crosshead down

When the crosshead moves up the displacement increases, so a command 

to RUN to a displacement which is smaller than the current displacement 

cannot be executed

However when the “Compression” option is chosen:

“4.59N” will be a compressive load

“-4.59N” will be tensile load

“23.7mm” will be a displacement below the zero position

“-23.7mm” will be a displacement above the zero position

The program command “RUN @ 75mm/min until time = 5.000sec” 

Will move the crosshead down

The program command “RUN @ -75mm/min until time = 5.000sec”

 Will move the crosshead up

When the crosshead moves up the displacement decreases, so a command 

to RUN to a displacement which is larger than the current displacement 

cannot be executed

The tension / compression setting would normally be selected before 

testing begins, i.e. when the displacement is zero and the load is close to 

zero. Note that if the tension/compression setting is changed after the 

crosshead has been driven and when the system is under load, the sign of 

the displayed values of the current load and displacement will change.

The following conventions apply to the display of speed, whether the 

“Tension” or “Compression” option is chosen, whether the crosshead is 

being driven under manual control or program control, a positive speed 

value indicates that the crosshead is moving up, and a negative speed 

value indicates that the crosshead is moving down.

The above paragraph initially may appear to be inconsistent with the fact 

that when developing a program the tension/compression setting affects 

the sign of the speed that must be entered. Consider however the user who 

only has operator access and therefore can neither inspect the test program 

nor see the settings within this “General” Preferences screen. It would be 

unacceptable to have a test system that responds in different ways, 

depending upon a setting of which the operator is completely unaware.

Units:

Force Units: Clicking on the arrow to the right of the current force unit 

will display a dropdown list of the units available, move the cursor to the 

desired unit and single click with the left mouse button to select that unit.

The units available are: kN, N, mN, kgf, lbf, ozf, MPa, kPa and psi If a 

unit of stress is chosen the OK and Default buttons will become disabled, 

and the “Cross Sectional Area of Sample:” text box will become enabled. 

Choose the appropriate sample symmetry by selecting either the 

“Circular:” or “Rectangular:” radio button, and type in the required
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dimensions in the units indicated It will be possible to confirm the 

selection of a force unit without entering the cross-sectional area

Displacement Units:

Clicking on the arrow to the right of the current displacement unit will 

display a drop-down list of the units available, move the cursor to the 

desired unit and single click with the left mouse button to select that unit. 

The units available are: millimeters, inches and %. If “%” is chosen the 

OK and Save as Default buttons will become disabled, and the “Original 

Length of Sample:” text box will become enabled. Type in the appropriate 

length in the units indicated. It will be possible to confirm the selection of 

a simple displacement unit without entering the original length of the 

sample.

Time Units:

Clicking on the arrow to the right of the current time unit will display a 

drop-down list of the units available, move the cursor to the desired unit 

and single click with the left mouse button to select that unit. The units 

available are: seconds, minutes and hours.

Sometimes a user will carry out a test on a source PC, save the data file, 

send it to a colleague to display the data on his  PC. When it comes to the 

choice of units, TMS-Pro will initially display data on the target PC using 

the units selected on the source PC.

Limits:

It is possible to set upper limits of: Load, Displacement, Time and Speed 

by entering appropriate values into each Dialog Box in the units indicated.

TMS-Pro will always impose a “global overload” equal to the physical 

capacity of the load cell. Think of the load maximum being imposed here 

as a (smaller) “local overload”. Displacement and speed values will be 

limited in a similar manner.

A test program  will stop running when the maximum absolute value of 

load or the maximum value of displacement or time is reached. When a 

program is being written TMS-Pro will where possible detect and display 

a warning when a command that will exceed any of the above maxima is 

creat ed.

Once the settings in this screen have been saved by clicking on Save as 

Defaults, they will apply to all subsequent new programs until they are 

changed

When developing a program TMS-Pro can, for example, detect a 

command to RUN to an illegal displacement. It cannot predict that 

running to a legal displacement will involve sustaining an illegal load.

Note: Clicking on Save As Defaults when the “General” tab is active will 

only save the displayed settings - i.e. to save the graph settings as defaults 

it will be necessary to click on Save As Defaults when the “Graph 

Settings” tab is active.

Graph Settings

This dialog box allows the appearance of the graph to be customized. 
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Note: this dialogue box can be accessed from different parts of TMS-Pro.

Details of the facilities available are given within the section on the Graph 

command

Automate

Selecting the Automate tab allows the user to select the “Return to zero 

displacement” box.  This feature makes the TMS-Pro return to the last 

point of position that the displacement was zeroed to, after the completion 

of each test.

System

Once a suitable PC has been set-up in the manner recommended, TMS-

Pro should be set-up for operation with the available hardware. This 

option is only available to master access. Choosing System option from 

Set-up menu will display a dialog box, with three tab options, “System

Settings”, “Load cell Deflection” and “Load Damping”. “System 

Settings” is the default; this enables serial communications and internet 

access options to be specified.

System Settings

Data from your Food Technology test stand will be sent via an RS232

link. TMS-Pro needs to know at which of the PC serial communication 

port the data will be arriving.

Note: When a new release of TMS-Pro boots up for the very first time, 

this Dialog Box will be displayed automatically. Click on the arrow to the 

right of the dropdown list box for “Primary Data Input” and select 

“COM1”, “COM2”, “COM3” or “COM4”. If you are not sure which port 

to select, your IT department will be able to advise you.

Internet Access If the PC running your TMS-Pro software is able to 

access the Internet, click in the “Internet Access;” checkbox and a tick 

will appear. It will now be possible to type in a path to access your Web 

browser. Your IT department will be able to advise you of the appropriate 

path. TMS-Pro will automatically use the Email software that has been 

set-up as the default within Windows.

When TMS-Pros Email facility is active, this will enable Emails to be sent 

directly to your local Food Technology representative. When a Web 

browser path has been specified, it will be possible to connect directly to 

the Food Technology Web Site.

Load cell Deflection
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This facility allows the load cell deflection compensation to be set up. 

TMS-Pro measures displacement – which is not necessarily precisely the 

same thing as deformation of the sample being tested. This is because the 

sample is not the only thing that deforms under load. TMS-Pro has the 

ability to compensate for these “other” deformations. This is achieved by 

typing a stiffness factor, in appropriate units, into the “Stiffness:” text 

box.

It is, of course, necessary to determine the stiffn ess not just of the load 

cell but also of the whole test system. Food Technology engineers, as part 

of the pre-delivery inspection procedure, do this for each test stand and 

load cell(s) combination when supplied complete. A certificate giving 

appropriate stiffness value(s) and serial number(s) is provided together 

with the load cell calibration certificate(s).

Under circumstances where it is acceptable to have a displacement error 

of, at the most, one millimeter, there is no need to apply load cell 

deflection compensation. This can be achieved by leaving the “Stiffness:” 

box empty. When the data file is saved, TMS-Pro will “remember” that no 

compensation has been applied. With uncompensated data, the *.for file 

can be loaded onto any other Imperial test system, and TMS-Pro will 

allow data obtained upon the second system to be added to the data 

obtained with the original system.

However, when load cell deflection compensation has been applied, the 

data saved become “tied” both to the serial number of the LOAD CELL 

used, and to the stiffness of the original system. Such data can still be 

loaded into TMS-Pro on any other PC – but access will be upon a “read-

only” basis.

Each copy of TMS-Pro maintains a database of the capacity, serial 

number, and stiffness of every LOAD CELL to which it has ever been 

connected. It is possible to maintain this database by selecting Setup, 

System, Load cell Deflection, then stiffness values can be updated, and 

data for load cells no longer available can be deleted.

It is important to realize that load cell deflection compensation is not 

applied until after the test has been completed. The deflection that is 

plotted during a test is the movement of the crosshead, i.e. uncompensated 

displacement data.

Sample Rate

This Dialog Box has four radio buttons labeled: “2 kHz:”, “1 kHz:”, “100 

Hz:” and “10 Hz:”, the default is “2 kHz:”. TMS-Pro -based systems 

enable data to be accumulated at the high frequency of 2kHz. 

When this is selected, TMS-Pro will display every peak and trough in the

load signal that it can detect. This may be absolutely marvelous for those 

users who are particularly interested in such fine structure. However, 

other users may well see this as “noise” - which just obscures the 
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relatively slow trends in load, which interest them. TMS-Pro's high 

response speed means that it is able to “see” tiny spikes and dips in the 

load – even those that only last for a few milliseconds

Selecting the “100 Hz” option means that each reading is averaged over a 

period of 10 milliseconds, this will have the effect of “smoothing” the 

data. Similarly selecting the “10 Hz” option means that each reading is 

averaged over a period of 0.1seconds, this will have an even greater 

smoothing effect.

Access

Master or Operator:

There are two levels of access for users of test systems controlled by 

TMS-Pro – master access and operator access. Choosing Access option 

from Set-up menu will enable the appropriate access level to be chosen.

To set up the system for operator access click on the option button to the 

left of the word   “Operator”, then click on OK button.

To set up the system for master access when no password has been 

entered previously, or when you wish to enter a password for the first 

time, click next to the word “Master”. Type a password into the “New 

Password:” text box, when you start this the OK button will become 

disabled, and the “Confirm New Password:” text box will become 

enabled. Re-type the new password into this text box, when you start this 

the OK button will become enabled. When you have finished, click on the 

OK button, and provided the same password has been entered both times 

this will become the new password, and the system will be in master 

access mode.

If you know the current password, and wish to obtain master access, type

the current password into the “Current Password:” and click on the OK 

button.

Every operator can have master access without needing to remember a 

password. If you wish all operators to have master access, TMS-Pro will 

accept the null string as a password; select the radio button to the left of 

“Master” then click on the OK button. Subsequently any operator who 

wishes to obtain master access will be able to do so by simply repeating 

this procedure

Operator Access Restrictions

The following facilities are not available to operator access:

Program  command (Test menu)

Calculation command (Test menu)

Graph command (Display menu) – The Overlay feature

Language command (Display menu)

Preferences command (Set-up menu)

Access command (Set-up menu) - the Password feature

System  command (Set-up menu)

Load Damping command (Set-up menu)
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Tools Menu Commands

Calibrate Zero Position

This selection allows the operator calibrate or  re-calibrate the Zero 

position for the displacement of the cross head. It initiates the same 

procedure that is call up at software start up and moves the cross head to 

the top most position. This position is now position 0.0 for running any 

test.

Upgrade

This option is only available to master access. It may be necessary at 

some time in the future to upgrade the firmware within your Imperial or 

Imperator test stand. To install the upgrade you will need to choose 

Upgrade option from Tools menu. TMS-Pro software upgrades can be 

supplied in two ways, floppy disc, or Email.

If the upgrade has been supplied by Email, you will need to run the 

upgrade file that was attached to the support Email. A PC file can be run 

either by clicking on the Start button and choosing the Run option, or by 

double-clicking on the file in Windows Explorer. If further advice is 

needed, all you should need to do is ask your IT department to help you 

“run a self-extracting ZIP file”. When the file is about to be run it will be 

necessary to put a blank 3½ -inch floppy disc into the A-drive of your PC; 

the upgrade files will then be exploded onto that disc.

When there is an upgrade disc in the A-drive of your PC, choose Upgrade 

option from Tools menu. Clicking on the OK button will display a copy of 

the standard Terms and Conditions for Food Technology software, if you 

wish to proceed with the upgrade click on the Yes, I accept button. When 

the upgrade has been successfully completed you will see the message, 

“Test Stand Re-programmed Successfully, Communications Re-

established.” – In the unlikely event of this message not being displayed, 

you should contact your Food Technology Agent, and advise him 

precisely what message has been displayed.

Make Diagnostic Report

This option is only available to master access. In the unlikely event of any 

difficulties arising with a TMS-Pro system, your local Food Technology 

Agent will almost certainly be able to resolve these quickly and 

effectively. It may however occasionally be appropriate for the remote 

report making facility of TMS-Pro to be used. If and when your Agent 

does recommend this, you will need to choose the Make Report option 

from the Tools menu. Your agent will then guide you through the 

following steps:

If your difficulties involve the development of a particular program , you 

should have this program loaded, and have already run the program to the 

exact point where you first experience a problem. Then, when prompted 

to do so, you will need to enable the “Include current test program, 

calculations and sample details” checkbox.
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If the PC does not have Internet access insert a blank 3½ -inch floppy disc 

into the A-drive of your PC, then clicking on OK will write a diagnostic 

report to the blank disc. This disc will then need to be posted to your local 

Agent (or the file on the disc will need to be Emailed to your local Agent 

from another PC.)

If the PC does have Internet access, TMS-Pro will detect the default 

Email client software. A diagnostic report, addressed to the TMS-Pro

International Helpdesk, will then be added to the “out-tray”.

Note: TMS-Pro is intolerant of competing with other software for the 

attention of the PC. If your Email software has booted up to send out a 

report, it is recommended that this software be closed down before 

continuing to use TMS-Pro.

Calibration & Service

It will not be possible to select the Calibration & Service option from the 

Tools menu, unless TMS-Pro is in master access mode, and a test stand 

with an appropriate LOAD CELL fitted is connected. Only Food 

Technology-approved calibration laboratories, Food Technology service 

engineers, or Food Technology-approved agents will have the ability to 

enter TMS-Pros Calibration & Service screen by typing in their special 

access code. Although the Calibration and Service Dialog Box is available 

to master access, another password will be required before the calibration 

facility itself can be accessed

Reconnect

If for any reason the PC loses communication with the test stand, TMS-

Pro goes into limited functionality mode. Choose Reconnect option from 

Tools menu to re-establish communication.  The error message that 

prompts you to use this facility is: “Test system has gone into limited 

functionality. You will now need to reconnect before testing can 

continue”, this message will often follow another error message which 

prompts the operator to click on an Abort button.
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Help Menu Commands

Help Menu

Choosing Help Topics option from Help menu will display a dialog box 

with three tabs. The Contents tab will be the default, and the main 

categories into which the Help system has been organized will be 

displayed. Double clicking on any category will display the sub-headings

into which that category has been divided. It is possible to display two 

levels of Help windows on the screen at the same time. For example, 

clicking on Programmed Testing, Test Menu Commands, and Program 

command, and then selecting the first option (also called “ Program

command”) from the list of sub-headings will display a list of all the 

program commands. Clicking on any item in that list will display a 

window giving the details of the particular command, but it will also leave 

the list of commands on the screen. This facility has been provided at the 

level within the Help system that will assist with the identification of the 

most suitable Program.

Clicking on the Find tab will display a screen similar to the Index screen, 

but it will be possible to find any word within the Help system. Clicking 

on the Index tab will display an alphabetical list of topics. Use the right 

scroll bar to scroll through the topic list, or type (into the upper text box) 

the first few letters of the topic you are trying to find and then click on the 

Display button. 

Email

This facility will only be available if TMS-Pro has been set up for access 

to the Internet.

Choosing Email option from Help menu will display a screen from your 

Email software that has been configured ready for sending an Email 

directly to your local Food Technology agent or distributor. In the event 

of any issue arising with a TMS-Pro system, this is likely to be a 

particularly efficient method to obtain support.

About

Choosing About option from Help menu will display a text box that 

includes:

The build date of your TMS-Pro software, precise details of the version 

numbers of all software and firmware, together with a copyright 

statement.

Contact data either for Food Technology Corporation or for your local 

Agent/Distributor.

A button linking directly to the FTC site on the World Wide Web.

Note that TMS-Pro cannot actually turn your modem on and dial the 

number of your Internet Access Provider. An error message advising that 

a “connection with the server could not be established” means that this 

needs to be done.
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